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1

Introduction

Thank you for purchasing easyDCP Player, a software-based solution for
playback and quality analysis of Digital Cinema Packages (DCPs) and
Interoperable Mastering Packages (IMPs). While easyDCP Player was designed
to be a quality assurance tool for checking packages before their final
distribution, it may also be a perfect low-budget solution for screenings in your
facilities. Bundling easyDCP Player with easyDCP Creator, an application for
creating DCPs or IMPs, and easyDCP KDM Generator, a tool for creating Key
Delivery Messages (KDMs), Fraunhofer IIS offers everything necessary to benefit
from the advantages of Digital Cinema.

easyDCP Player handles video resolutions up to 4K at arbitrary frame rates as
well as multi-channel audio, subtitles and captions. The easyDCP Player+
edition is even capable of playing back encrypted DCPs and lets you watch
stereoscopic DCPs. Furthermore it allows you to export your DCPs’ or IMPs’
audio, video and timed-text content to allow for fast repackaging, creation of
proxies for subtitling or transcoding into other formats.
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Feature QOverview

easyDCP
Player

easyDCP
Player+

Demo
Version

* kkk

GPU-based real-time decoding

Software-based real-time decoding ™

Reads DCPs, MXF, JPEG 2000, TIFF, DPX, PNG, JPEG,
GIF, BMP, PPM sequences, M3U playlists

Playback of unrendered easyDCP Creator projects

Validation (incl. XML validation) report

Customizable color space conversion

Adjustable playback frame rate

Supports discarding of resolution levels

Audio waveform visualization

Multiple Timed Text Tracks (Text, PNG) visualization

Add external subtitles on the fly

Finely-tunable Quality-vs.-Performance Trade-off

Timeline shows reel boundaries and subtitles

IMF playback & validation

HD-SDI output™

30 bit DisplayPort output™”

Playback of encrypted DCPs with KDMs

Stereoscopic playback

Export to JPEG 2000, QuickTime, TIFF, DPX, WAV

XXX X Ix X NININ NN SIS

ANANANANANANEANANANANANANANENENANENAYAY

AN ARNANANANANANENANANENENENANERN

Available for 64 bit Windows 7, Windows 8

Available for 64 bit Mac OS X (10.7-10.10)

AN

ANIAN

ANIAN

*) Required graphics device setup described below
**) Required hardware described below

***) Windows only
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3.1

3.2

System Requirements

easyDCP Player comes with a GPU-based JPEG 2000 Codec and a software-
based JPEG 2000 Codec. The GPU-based codec is only available for Windows
and requires an additional graphics device.

Provided the proper hardware is available, both codecs are capable of decoding
2K DCPs and IMPs (with up 250mbit/s, 24 fps) in real-time. This is sufficient for
smooth real-time playback of monoscopic and stereoscopic packages with a
resolution up to 2K (2048x1080). easyDCP Player even allows to open and play
4K content in full resolution, though by default it will opt to efficiently decode
only the 2K portion of a 4K DCP.

Software-based decoder

In order to guarantee real-time playback with at least 24 fps, the software-
based decoder needs to be backed up by a fast multi-core CPU with at least
four cores. It is recommended to download the demo version in order to find
out how your system performs.

The scalability of JPEG 2000 encoded images can be exploited to watch a 1K or
0.5K resolution preview in real-time on systems that don’t have a sufficiently
powerful CPU. Optionally you can choose to upscale the lower resolution
preview to full-screen, without negatively impacting the maximum speed.

GPU-based decoder (Windows only)

For smooth playback in GPU-based mode, easyDCP Player always requires a
bundle of two graphics devices - a primary device for rendering (with OpenGL)
and a secondary device for video decompression (with NVIDIA® CUDA®?).
Using a sufficiently powerful graphics device pair, the GPU-based codec can
provide real-time playback even for framerates above 24 fps or UHD IMPs with
up to 800 Mbit/s. Both graphics devices should ideally be connected with PCle
x16.

Primary graphics device

This device is dedicated to rendering video and optionally color post-processing,
using OpenGL. Displays need to be attached to this device. It is recommended

T CUDAW® is a registered trademark by the Nvidia Corporation

6 of 70 22/10/2015



to install the primary device in the mainboard'’s top slot. This device does not
necessarily need to support the NVIDIA® CUDA®? technology.

In order for the 3D output option “Quad-buffered stereo” to be available, this
device needs to support quad buffering (e.g. NVIDIA Quadro®?® series). Using
this technology, easyDCP Player+ supports the use of active shutter glasses or
Stereo over Dual-DVI. The graphics driver control panel can be used to specify
how stereo images should be processed by the primary graphics card.

In order for the “30 bit Colors” option to be available, this device as well as the
connected display need to support 30 bit per color.

When a HD-SDI output device is used and the option “Enable subtitling, color-
processing and scaling” is activated, images are also processed with the
primary graphics card, before they are emitted to the HD-SDI device. In this use
case, a NVIDIA Quadro® series graphics card (even a low-end model) might
also be beneficial for a better render performance. Otherwise, a mid-range
NVIDIA® GeForce® device, e.g. NVIDIA® GeForce®* GTX 750 Ti, is a good
choice.

Secondary graphics device

This device is dedicated to the computationally very expensive JPEG 2000
decompression. It must not be used as a video output. For best performance,
this device should be a CUDA®-enabled graphics card (e.g. from the latest
NVIDIA® GeForce® series) with many CUDA®-cores installed in the
mainboard’s secondary slot. Please refer to www.easydcp.com for a list of
supported devices. It should be connected with PCle x16. PCle x2, x4 or x8 will
lower the performance significantly. Make sure to connect both on-board
power connectors to the power supply unit and that the power supply unit
meets the system’s requirements.

2 CUDA® is a registered trademark by the Nvidia Corporation
3 NVIDIA Quadro® is a registered trademark by the Nvidia Corporation
4 NVIDIA® GeForce® is a registered trademark by the Nvidia Corporation
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4 Installation

The installation of easyDCP Player will only take a few minutes. You can
download a single executable setup file (for Windows and for Mac OS X) here:

WWW.easydcp.com

Please check frequently to make sure you have the latest version.

To install easyDCP Player, make sure you have the required user rights (i.e.
admin rights).

4.1 Installation on Windows

In Windows OS systems, double-click the easyDCP Player installer. The
following dialog should appear (version may differ):

(& easyDCP Player+ 3.3.0 Setup = =

Welcome to the easyDCP Player+
3.3.0 Setup Wizard

This wizard will guide you through the installation of easyDCP
Flayer+ 3.3.0.

Itis recommended that you dose all ather applications
before starting Setup. This will make it passible to update
relevant system files without having to reboot vour
computer.,

Click Next to continue.

. fraunhofer.de

Press , Next >" to continue installation or ,Cancel” to abort.

After pressing ,Next >" the License Agreement window appears. Please read
the license agreement carefully. To agree with the license and continue the
installation process, press “Agree”. Next, choose a target folder. easyDCP
Player will be installed in the “Destination Folder”. If you want to change the
destination folder, click the “Browse” button and select another folder. Make
sure you have the required user rights (i.e. admin rights) to write to that folder.

Please verify you have sufficient free disc space available on your system. The
required disc space is displayed in the text “Space required” below. Your free
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disc space is displayed in the text “Space available”. This will be recalculated
every time you change the destination folder.

After pressing “Install” the installation process window appears. This
installation process should take only a few seconds. After finishing the
installation process, the following dialog should appear:

(i1 2asyDCP Player+ 3.3.0 Setup EI_I—J

Completing the easyDCP Player+
3.3.0 Setup Wizard

easyDCP Player+ 3.3.0 has been installed on your
computer,

Click Firish to dose this wizard.

Launch easyDCP Player +

M
a.fraunhofer.de

After successful installation, easyDCP Player will be installed on your computer.
In your start menu'’s application list, you will now find an entry called
“Fraunhofer easyDCP Player” that contains links to open easyDCP Player,
uninstall easyDCP Player or open this user manual.

4.2 Uninstallation on Windows

To uninstall all easyDCP Player components run “Remove easyDCP Player” from
your windows start menu.

. Fraunhofer easyDCP Player+ 3.3.0
@ easyDCP Player+ 3.3.0 User Manual
@ a5yDCP Player+ 3.3.0
(3 Remove easyDCP Player+ 330

If your easyDCP Player start menu entry does not exist anymore, go to the
folder where you installed easyDCP Player and run the executable “Uninstall
easyDCP Player 3.0.0.exe” by double-clicking. The default location is
“C:\Program Files (x86)\Fraunhofer lIS\easyDCP Player 3.0.0".
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(9 easyDCP Player+ 2.2.0 Uninstall l = éj

= Uninstall easyDCP Player+ 3.3.0
A Fraun hOfenl; Remove easyDCP Player+ 3.3.0 from your computer,

easyDCP Player+ 3.3.0 will be uninstalled from the following folder. Click Uninstall to start the
uninstallation.

Uninstalling from: C:'Program Files\Fraunhofer 115\easyDCF Player+ 3.3.0%

Mullsoft Install System v2.46

[ Uninstall J [ Cancel

~Uninstalling from” shows the folder where the easyDCP Player installation is
located. All files and directories will be deleted, except for user files (e.g.
licenses). Directories including user files will not be removed. This way, if you
update easyDCP Player to a newer version, your license file will be found and
re-used.

To start the un-installation process, press the button , Uninstall” or ,,Cancel” to
abort. Make sure you have the required rights (e.g. admin rights).

7 ~
{9 easyDCP Player+ 2.2.0 Uninstall l = - ]

? Uninstallation Complete
'é Fraun hOfeul; Uninstall was completed successfully.

Completed
L ——_

Delete file: C:'\Program Files\Fraunhofer IIS\easyDCP Player + 3.3.0\binYibxmlsec-op... =
Remove folder: C:'\Program Files\Fraunhofer 11S\easyDCP Player+ 3.3.0%binY

Remove folder: C:\Program Files\Fraunhofer 115\easyDCP Player+ 3.3.04

Delete file: C:\ProgramData\Microsoft\Windows\Start Menu\Programs\Fraunhofer ea...
Delete file: C:\ProgramData'Microsoft\Windows\Start Menu'\Programs\Fraunhofer ea...
Delete file: C:\ProgramData'Microsoft\Windows\Start Menu'\Programs\Fraunhofer ea...
Remove folder: C:'\ProgramDataMicrosoft\Windows\5tart Menu'\Programs\Fraunhof...
Delete file: C:\Users\Public\Desktop\easyDCP Player+ 3.3.0.Ink

Delete file: C:\Users\freisims \AppData\Roaming Microsoft\Internet Explorer \Quick La... |_|
Completed [~

Mullsoft Install System v2,46

< Back Close Cancel

After a few seconds the uninstallation of easyDCP Player should be complete.

Press the button ,, Show details” to show details which files were deleted. Press
,Close” to finish uninstalling easyDCP Player.
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After the successful uninstallation only user files in the application data folder
will remain on your system. User files include:

e Settings file (settings.ini)

e License file

e Color transform files

e Content key files (KDMs and easyDCP Digests) (PLUS-edition only)

e Public certificates, private key, user password file (PLUS-edition only)

Make sure you have the required rights (e.g. admin rights) to do such an
operation.

4.3 Installation on Mac OS

The installation image for easyDCP Player or easyDCP Player+ looks like the icon
below. This file may be named differently, depending on which version was
downloaded. Double-click the icon to mount the image. A license information
screen pops up. Read the software license agreement carefully.

Fraunhofer_easyDCP_Player_Plus_3.3.0_x64_(2015-06-11).dmg

IMPORTANT - Read this
License Agreement carefully

befare clicking on the License agreement

“Agree” button. By clicking

on the "Agree” button, you 1. General remarks

agree to be bound by the These present Business Terms apply 1o use of the easyDCP Player+
terms of the License software for test purposes. Customer terms contradicting
Agreement. or differing from these Business Terms have no validity.

—_
Ancillary agreements, amendments or supplements must be in writing. L
i

Fraunhofer reserves the right to offer the software to other customers.

easyDCP_Player_Plu

s_3.3.0.dmg
48,2 MB

2. Use rights

2.1 Fraunhofer grants the customer the simple (non-exclusive) right to
use the easyDCP Player+ software under the provisions of the following
Terms for test purposes. No grant of rights going beyond the following
Terms is connected with the provision of this software. In particular,
Fraunhofer retains for itself all dissemination, exhibition, demenstration,
performance and publication rights to the software.

| Print || Save... | | Disagree | | Agree |

To agree with the license and continue the installation procedure, press
“Agree”. After the image has been opened a new drive is mounted and a
window will open.
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4.4

4.5

e 006 __ Fraunhofer easyDCP Player+ 3.3.0

(«i>) Bl=mmj(#-](=-](z](2](e](8] @
FAVORITEN
FREIGABEN — ‘
GERATE ’
) Fraunhofer eas... 2 YEN Player+
A———
Applications easyDCP Player+ 3.3.0

You need to copy the package into a directory of your choice. In order to copy
it into the Applications directory, simply drag and drop the easyDCP Player icon
onto the Applications icon.

Uninstallation on Mac OS

Simply drag your easyDCP Player application icon into the trash.

All user files in the library folder will remain on your system. User files include:

Settings file (settings.ini)

License file

Color transform files

Content key files (KDMs and easyDCP Digests) (PLUS-edition only)

Server certificate set (PLUS-edition only)

Demo Mode Restrictions

In demo mode,

e Full-resolution playback is limited to 15 seconds. Afterwards, the quality
is reduced and audio is muted.

e (PLUS only) playback of encrypted DCPs and ingesting KDMs or
easyDCP Digest files is locked

e (PLUS only) The export module is locked
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4.6

4.7

4.8

License Activation and Certification

Download free demo versions of easyDCP Player or easyDCP Player+ at

WwWw.easydcp.com

These free versions are subject to the demo mode restrictions listed in chapter
4.5. In easyDCP Player, go to “context menu->Help->Request License &
Certificates” and fill in the licensee’s name, the URL that shall be stated in the
custom server certificates (easyDCP Player+ only) and a password that is used to
protect access to the certificates. If the computer is connected to the Internet,
click the “submit” button. The default web-browser will open
www.easydcp.com, where further instructions will guide you through the
purchase process.

After the purchase, a link to the commercial installer as well as a zip file with
the License and certificates will be available for download within your user
account at www.easydcp.com. The zip file can be dragged & dropped into the
commercial easyDCP Player installation to unlock it.

The procedure is also described in a screen cast at www.easydcp.com.

View current License Information

To view the license details, right-click the canvas to open the context menu and
select ,,Help -> License information”.

Application Data and Settings

easyDCP Player automatically creates an application data folder. It contains the
settings file as well as a folder where the server certificates are stored, a
repository for KDM and easyDCP Digest files and a repository for color
transform files.

On Windows, it is located in <User Application Data>/Fraunhofer 1IS/easyDCP
Player/ and <User Application Data>/Fraunhofer [IS/easyDCP Player+/

The user application data folder on Windows 7 is in "C:/Documents and
Settings/<username>/Application Data/. On Windows 7 it is located in
C:/Users/<username>/AppData/Roaming/

A shortcut is to just enter %APPDATA% into the address bar.

On Mac OS X, it is located in \Users\<username>\Library\Application

Support\Fraunhofer lIS\easyDCP Player\ or
\Users\<username>\Library\Application Support\Fraunhofer lIS\easyDCP Player+\
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49 Software Upgrade

To upgrade easyDCP Player, log into your user account at www.easydcp.com.

Before installing a new version, please uninstall your existing version of
easyDCP Player.

Make sure your license is valid for the new version by reviewing the license
information (hit ‘F2’). If you need a new license for the new version, you may
purchase it at www.easydcp.com.

Only major releases require a new license, e.g. 3.0 to 3.1. Point releases do not
require a new license, e.g. 3.0.0 to 3.0.1.
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5 Playback

When launching easyDCP Player, a splash screen will be displayed during the
start-up phase.

At the first launch of easyDCP Player+, a message will pop up, prompting you
to request a server certificate. Each easyDCP Player+ installation has an
individual server certificate, which will be created by Fraunhofer IIS. This
certificate is required to be able to receive Key Delivery Messages (KDMs),
which unlock encrypted DCPs. Please refer to chapter 9 for more details.

This is the main window:

A x| Playlist Editor - x

Hash Checker o ave ear 00:00:00:00 & auto-hide

Title Type

Y AT

easyDCP"

00:00:00:00 00:12:14:00

5.1 Opening a DCP/IMP

To open an existing package, click on the button with the eject icon in the
bottom left corner.

rs
-

Open Package
Open Audio/ideo File(s)...
Open Playlist...

15 0f 70 22/10/2015



Drag and Drop: For convenience you can also drag and drop supported
sources directly onto the canvas, playlist editor or the playback toolbar, or
onto the application icon to open a new instance. Supported sources are

e one or more DCP/ IMP folders

e a CPL/ Assetmap or PKL .xml file

e anumbered file sequence (see 2 for supported file types)
e an audio or video *.mxf file or multi-channel *.wav file

e a *.m3u playlist file

e a DCP/IMP project file (*.dcpproj), created with easyDCP Creator

If one or more packages were opened, the playlist editor will pop up. It lets you
select a single composition playlist for playback or arrange a playlist. You can
always drag further assets into the playlist editor or re-open it from the context-
menu.

For some of the fields, the tooltips contain more information or metadata like
the creator, issue date, etc. You can also browse the XML or MXF files, or
expand/collapse all items.

Playlist Editor
Hash Check Log Save Clear
Title 3 Length
TEARSOFSTEEL_FTR_S_EN-XX_51_2K_20130822_FHG_INT_OV
CPL 2048 x 853 00:12:14:00 feature
DCP feature 2048 x 853 24 fps 5.1
Reel 204
Picture

Sound

G_SMPTE_OV

CPL 1 30 00 feature
Reel

Picture
Sound

PlayOne P
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5.2  Opening a Supplemental package (VF)

A supplemental package (typically ends with “_VF", which stands for Version
File) is an add-on container that does not contain all the track files it references,
but relies on the presence of an additional package (typically one that ends
with “_OV", which stands for Original Version). The concept is well explained
at www.digitalcinemanamingconvention.com/appendix _8.asp.

Often, the folder that contains the VF, resides within the folder that contains
the OV, but other times, the two folders are located next to each other on the
same level.

If a folder with an OV is opened, easyDCP Player will automatically detect any
additional VF packages located within the folder and load them as well.

When only the VF is loaded into easyDCP Player, the original location of all
those track files that are not contained in it, is unknown. These track files, as
well as the whole Composition is drawn in grey.

When the corresponding OV package is also loaded into easyDCP Player, it will
automatically resolve all missing references from the VF against the OV and the
VF will become available.

5.3  Opening an encrypted DCP

PLUSFeature

When an encrypted DCP is opened and the keys have not yet been ingested,
the missing keys can be loaded from the corresponding Key Delivery Message
(KDM) or easyDCP Digest (*.dcpdig) file. Either click on the lock icon or simply
drag & drop the file into the playlist editor.

Playlist Editer @

Hash Check  Log Save  Clear 00:00:02:06 & auto-hide

Length ps Resolution

& 00:00:02:06

Play One Play All Close
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If the keys are read from a Key Delivery Message (KDM), they are only valid
within a certain time window (“engagement window").

Playlist Editor \E‘

Hash Check Log Save Clear 00:00:02:06 & auto-hide

Title Length ps Resolution
TEST-SUB-HD-ENC_TST_F_E

O = & & 00:00:02:06 241 1920 x 1080
DCP feature 192 : Stereo

TEST-SUB-HD-ENC_TST_F_EN-X

5.4  Opening Audio/Video File

To open an existing media essence other than a DCP/IMP package (e.g. audio
file, video file(s)), click on the button with the eject icon in the bottom left
corner.

.
=
Open Package...

Open Al deo File(s).

Open Playlist.
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PLUSFeature

A dialog appears:

@8 Open Audio and Video File(s) (oS

Audio

@ Integrated Source

Audio

Cancel

Here you can select single video and/or audio files. Currently supported video
sources are numbered *.j2c file sequences or OP-Atom MXF files with DCI-
compliant JPEG 2000 content. Currently supported audio sources are Wave
files with uncompressed PCM samples or OP-Atom MXEF files with
uncompressed PCM samples. The easyDCP Player+ edition also supports
encrypted MXF files. When an encrypted MXF file is selected, a button with the
key icon will become visible, allowing you to enter the decryption key. Content
keys for individual encrypted MXF files are not looked up in the repository. You
will always have to re-enter them, either by entering the key manually, or by re-
ingesting the corresponding content key file (easyDCP Digest). The “OK”
button will only be enabled when all fields are either empty or contain a valid
essence.

It is also possible to combine two MXEF files or file sequences to a stereoscopic
video asset by clicking on the “3D"” radio button.

@8 Open Audic and Video File(s) [

Video
©20 @3

Left

Right:

Audio
@ Integrated Source

Audio

Cancel

It is perfectly possible to arbitrarily combine any two kinds of video sources: file
sequence with file sequence, file sequence with MXF, MXF with MXF. If a
stereoscopic MXEF file is selected, only its first channel is regarded. If the same
file sequence is selected for both channels, the sequence will be interpreted as
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5.5

two interleaved channels, i.e. frames at even indices will be used for the left
channel, frames at odd indices for the right channel.

For convenience, supported file formats can also be dragged onto the
easyDCP Player+ canvas or playlist editor.

Both video channels are required to have matching technical properties like edit
rate and resolution. The shorter channel’s duration will be used as the overall
duration.

Opening and Creating a Playlist

easyDCP Player has limited support for playlists. Currently, only the m3u format
is supported. To open an m3u file, drag and drop it onto the canvas or the
easyDCP Player icon. Items will be played back to back. Enabling the loop
button will cause the whole playlist to be looped, not individual items. Playlists
may be nested, but not recursively nested.

A playlist can be created from within the Playlist Editor, with the “Save Playlist”
option.

The simplest form of a m3u playlist is a text file with one absolute path to a
source asset per line.

Optionally, each line may be preceded by a line with metadata that starts with
"#EXTINF:". It is followed by a number that denotes the maximum number of
seconds the asset shall be played. A negative value or zero indicates that the
full length shall be played. If the asset is shorter than the provided duration or
the easyDCP Player demo’s maximum playback duration limit is reached, the
duration stated in the playlist is ignored.

Following the duration, separated by a comma, a title needs to be specified.
However, easyDCP Player will continue to display the asset’s title and not the
one stated in the playlist. A proprietary extension is that an additional, comma-
separated, field, stating the audio volume, can be supplied. Valid values are
numbers between 0-100.

All blank lines and lines that start with “#"are ignored.

Sample:

#EXTM3U

# play only first 5 seconds
#EXTINF:5, title 1
\\server\DCPs\sample DCP\cpl.xml

# play at 50% audio volume
#EXTINF:0, title 2, 50
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5.6

5.7

\\server\FileSequences\j2c\img 00.j2c
C:\DCPs\sample DCP\video.mxf

Opening high-bitrate content

According to DCl specifications, the video bitrate for DCPs shall not exceed 250
Mbit/s. Surpassing that limit will cause easyDCP Player to generate a warning
message. To set a custom limit, e.g. when working with high-framerate (HFR)
content or high-bitrate (HBR) content, open the playlist editor window (Press
“P" or context menu -> Playback -> “Playlist Editor”) and modify the bitrate
setting. easyDCP Player will remember custom values set for each item across
program starts.

Type

0 B & cr

Maximum Bitrate [Mbit\s]

Hash Checker Log Save Clear Play One  Play All 00:0 O auto-hide ([ dockable

Length Kind

AudiaTracks

Segment
Sequence
Picture
Picture
Picture
Picture
Picture
Picture
Picture

Picture

- [ segme
+ [l Picture
+ W] stereo
+ ol 51

The pendent to a DCP’s reels in an IMF package are segments. A segment may
contain audio, picture and/or timed text. However, in contrast to DCPs, a reel
can contain a sequence of multiple tracks of the same essence (e.g. picture)
that will be played back-to-back. In the screenshot above, the first segment has
a sequence of eight tracks that will be played back to back.

Another concept that is new in IMF packages is that of virtual tracks. In the
screenshot above, the composition has two alternative virtual audio tracks —
one with stereo channel audio and another one with 5.1 audio. The active
virtual tracks are printed in bold.
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o

v Stereo

51

When opening the composition, the first virtual track will initially be opened.
Subsequently, any other audio track can be selected by clicking the speaker
icon in the toolbar.

5.8  Playback control

» Play/Pause Playback:

Starts or pauses playback of the currently loaded media asset (hit ‘Space’).

C Loop Video:

If this option is activated, the currently loaded playlist will be restarted from the
beginning when it reaches the end.

20 53
2048 x 853

£ Discard resolution level:

By clicking this button, a resolution level of the JPEG 2000 code-stream will be
discarded. Discarding a resolution level will half the resolution in both
dimensions, while speeding up decompression times. Discard a resolution level,
if the picture essence cannot be played back in real-time.

£ Add resolution level:

By clicking this button, an additional resolution level of the JPEG 2000 code-
stream will be added. Adding a resolution level will double the resolution in
both dimensions while slowing down decompression times.
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(@8 TEARSOFSTEEL_FTR_S_EN-XX_51_2K_20130822_FHG_INT_OV - easyDCP Player+ (unlicensed) (=] B [t

File Playback Asset View Help

Canvas

a “Pr» i C s S 24005 2 O O 256x107 )

00:03:32:13 00:12:14:00

As seen above, a DCP contains multiple embedded resolutions.

¢ Fit To Window

This button is grouped with the resolution level buttons as well as the combo
box listing all accessible embedded resolutions. Normally, the application
window resizes itself to the decoded video resolution, which is always visible in
the drop-down combo box displayed above. If the window is too small to fit
the video resolution, scroll bars appear. When the “Fit to Window"” button next
to the combo box is checked, however, the displayed video resolution will be
artificially scaled to optimally fit the current window size. Tip: In order to speed
up the decompression, discard one resolution level and scale the resolution
back up to full screen by enabling the “Fit To Window"” option. The loss in
quality is acceptable in many cases.

3
n TEARSOFSTEEL_FTR_S_EN-XX_51_2K_20130822_FHG_INT_OV - easyDCP Player+ (unlicensed) { o |8 i&]
File Playback Asset View Help

Canvas

a “«“PMH» M C s 3 24005 2 O O 256x107

00:03:32:13 00:12:14:00
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The above screenshot shows the same 256x107 pixels embedded resolutions,
but with the “Fit to Window" option enabled.

Frame number:

Enter a value to directly jump to a specific frame number of the currently
loaded asset. You can also use the blue slide bar to jump to a specific location.

Frames per Second:

24,00 fps

Arbitrary frame rates can be specified. If the audio edit rate is known (as is the
case when playing a DCP, IMP or MXF), audio will only be played for the
original edit rate. If a fractional frame rate is specified, the time code display
will round to the next even integer. Hence, the time code no longer matches
the world time.

Timed Text:

) SDI @
v en (Open Subitle)

en (Closed Caption)

Colorize

The currently opened package’s timed text tracks can be shown or hidden. To
be able to distinguish the tracks they can be colorized.

Volume control (audio)

1)
v Stereo

51

Mute

Change the audio volume with this slider from left to right. At full left, audio is
muted. At full right, audio is played back at 100% of volume, no additional
gain is added to the audio. When clicking the speaker-symbol a menu will
open. The option to mute all audio is always available. In case an IMF package
with virtual audio tracks is currently opened the track can be selected. If lossless
audio output is enabled (see Options, Audio tab), volume control is not
available.
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When playing back an m3u playlist, it is possible to predefine the volume level
for every package in the m3u file as shown in chapter 5.5. In this case, the
volume slide will be automatically updated.

Timeline

The timeline displays the playback progress of the current playlist item.
Hovering over it will display additional information, clicking will jump to the
associated time code. If the currently playing asset contains subtitles, markers
will be drawn on the timeline at the fade-in points of all subtitle entries.

F S 2400fps

00:00:04:04 L

Multiple reels inside a single package will be drawn in slightly different colors
for easier distinction. Additionally, the context entries in Playback->"Jump to”
allow navigation between reels, subtitles or playlist items.

5.9  Subtitle Inspector

Since version 3.0 of the easyDCP Player(+), a Subtitle Inspector window can be
used to display subtitles and their properties for an opened asset. A Subtitle
Inspector window can be opened by using the easyDCP Player(+) context menu
(right click on Canvas) or main menu -> Asset -> Subtitle Inspector #1 to #4 (or
using the shortcuts CTRL+1 to CTRL+4). Each window can be used to show
different Subtitle Tracks and search results. By default, the same subtitles like in
the Canvas are shown in the Subtitle Inspector windows. To change this
behavior, the “Tracks” menu can be used by disabling its “Same as Canvas”
option and selecting the subtitle tracks arbitrarily and independently from the
Canvas.

a % Playlist Editor

Tracks _ Hash Checker

Time Out v de (Closed Caption) [External]

v en (Closed Caption) [External]

« Same as Canvas

Additionally, the search box in the top of the window can be used to instantly
find particular subtitle entries by typing in, for example, a part of their text or
their time code. All visible columns will be searched and wild-cards like “?" and
“*" can also be applied.

250f 70 22/10/2015



Subtitle Inspector #1 P

00:00:**:03 Tracks _

Text Du ratinn‘ Time In Time Qut

Example Subtitle (Closed Caption) Tex... 00:00:02:03 00:00:01:12 00:00:03:15

The order of the columns can be re-arranged via drag & drop of the column
headers. The column headers’ context menus contain options to hide or show a
particular column.

Selecting a subtitle in the Subtitle Inspector by clicking on it automatically
jumps to the first frame the subtitle appears (please note that the subtitle could
still have a high transparency in that first frame because of the fade-up time).
The other way around, while playback is running, the subtitles that are
currently visible in the Canvas are also marked in the Subtitle Inspector
windows.

For testing purposes, each subtitle track can be rendered in a different color by
either enabling the “Colorizing” option in the Subtitle menu of the tool bar or
in the context menu of any subtitle entry in the Subtitle Inspector (right click on
a subtitle entry to open up the context menu). Using this context menu,
alternatively a custom color can be selected for each subtitle track by choosing
"Pick a Color” for one of its subtitle entries. Moreover, by clicking on “Extra
vertical offset”, each subtitle track can get an additional offset for its position
in the image, so all of its subtitle entries get moved up or down in the image.
This is convenient when comparing two alternative subtitle tracks (e.g. two
different languages) that would normally overlap each other. The default
percentage of +/-40% can also be customized in the context menu by using
the “+10% " and “-10%" options.
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Subtitle Inspector #1

Search...

Duration Time In Time Out

00:0( v Colorizing

Pick a Color
Example Subtitle (Closed Caption) Tex... 00:0( )0:00:12:00
Extra vertical offset (-20%)

a “«» C =105
-10%

00:00:09:03
Fit column sizes

Subtitle Inspector #1
Search...

Text Duratin:rn‘ Time In

Beispiel Untertitely _
o il Colorizing

10:00:02:03 00:00:01:12

Pick a Color

ample Subtitle ((  Eyira verical offset  '0:00:02:03 00:00:01:12
+10%
-10%

Fit column
5.10 Adding external subtitle files
easyDCP Player (+) can also load external subtitles on-the-fly via the playlist
editor window. To do so, right click the desired package and choose “Add

subtitle file(s) to Composition” or “Add subtitle file(s) to Reel”. Drag & Drop is
supported as well.
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(2011-10-07T17:07:3
Return

Play One Ctrl+Return
All from Here Return

- e uf
Browse XML _ One Ctrl+Return

in Explorer
" w in Explorer
Remove Playlist tem Del
- o Subtitle file(s) to Reel

dd Subtitle file(s) to Composition...
Expand

S GELD]
Collapse

Collapse

E Il

Collapse All

Collapse All

Please note that it makes a difference whether you drop the subtitle on the
composition or on a particular reel. In case you selected to add the subtitle file
to the composition and its length exceeds the duration of the first reel, the
remaining subtitle contents will be added to the following reels (if any). When
you later unwrap the package in the Export dialog (see chapter 6), the single
imported subtitle file will then be split up into multiple files (one for each reel).
“Add subtitle file(s) to Reel” will only affect the selected reel. Make sure that
the subtitle contains no entries beyond the reel’s end.

To remove an external subtitle element, right click it and choose “Remove
Subtitle” from the context menu.

e For convenience, no distinction between the different supported
subtitle formats (SMPTE DCP, Interop DCP, IMF) is made. For instance,
adding SMPTE subtitles to an Interop package or vice versa will work
as expected. When the package is exported, the subtitle format will
automatically be converted.

e You may add multiple subtitle files at the same time.

e In order to distinguish them from regular ones, external subtitle
elements in the playlist editor are displayed in italics.

e easyDCP Player(+) will automatically monitor external subtitle files for
changes and update them accordingly (e.g. in case you modify the
wording in an external editor)
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5.11

Color Transforms

O Color Transforms /3D LUTs

@ Color Spaces

Source Color Space
XYZ (DCI)

Computer Monitor:
Standard RGB (sRGB)
HD-SDI Monitor:

RGB P3 (DCI)

2048 x 858 v X

00:12:14:00

With this button you can select a color transform. Enabling a color transform
results in a better representation of how colors and “look” appear on the
screen. Multiple standard color transforms are included with easyDCP Player.

Color Transform Presets

In versions prior to 3.3.2, color transforms were of the form “source space ->
target space”. Each transform is represented by a file in the color transform
repository. They use a proprietary XML format. The files can be edited and new
ones can be added. These types of color transforms are still available for
backwards compatibility. In the screenshot above, select the “Color Transforms
/ 3D LUTs"” group box. The repository can be opened by clicking the folder icon.
New files or 3D LUTs (*.3dl) can be added with the plus icon.

Color Space Presets

Beginning with version 3.3.2, the more flexible way to define color transforms
is by individually assigning source and destination color spaces. The source
color space is specific to the currently loaded package and will be restored the
next time the package is loaded. The first time a package is loaded, the source
color space will be automatically inferred from the metadata. The destination
color spaces can be individually selected for the computer monitor and for the
SDI monitor. These selections will be permanently maintained. The color spaces
are also represented by files that are located in the color space repository. The
files are stored in a proprietary XML format that is different from the one used
for the legacy color transform files. This repository is shared by both easyDCP
Player and easyDCP Creator. Existing presets can be edited and new ones can
be created. When adding new files, please make sure to assign a unigue name.
The “comment” attribute will be displayed as a tool tip. When creating a new
preset it is recommended to copy and paste any of the existing presets and
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make adjustments as opposed to starting from scratch. All possible values can
be looked up in the “template.xml.example” file located in the repository.

ICC Profile

Optionally, a separate ICC profile file can be referenced. This works with both
the color transform and color space formats. The profile file needs to be
located in the same folder. This profile will then be embedded when exporting
QuickTime or TIF files to enable proper downstream color management.

Example: DCP

@8 TEARSOFSTEEL_FTR_S_EN-XX_INT_51_4K_20130805 - easyDCP Player+ 3.3.2 o=

Computer Monitor:
Standard RGB (sRGB)
Hi onitor.

RGB P3 (DCI)

S 2400fps

0007 54— 00:12:14:00

As seen above, images look greyish or greenish, when displayed in the
package’s native X"Y'Z’ color space with 2.6 gamma and P3 white point. When
viewing on a computer monitor with the sRGB color profile, the colors need to
be converted into the sRGB color space.
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{8 TEARSOFSTEEL_FTR_S_EN-XX_INT_51_4K_20130805 - easyDCP Player+ 3.3.2

File Playback As: View Help

Canvas

S 2400fps

00:07:54:12

O Color Transforms /3D LUTs

& Color Spaces

Source Color Space:
XYZ (DCI)

Computer Monitor:
Standard RGB (sRGB)

| Monitor:

00:12:14:00

5.12 2D/3D

The 2D/3D context menu lists the same options as the 3D button in the
detachable control bar. Features are only enabled when a stereoscopic asset is
PLUSFeature loaded. Both the context menu and the button are only available in the

easyDCP Player+ edition.

Open »
Playback »

Log Cirl+L
Options o

»
»

v Left Channel Only
»
. Right Channel Only

Both Channels Al
13
Content Decryption 3

Help »

Exit
Yellow-Blue Colored

Yellow-Blue Gray
Red-Blue
Red-Blue True
Green-Red

Green-Red True

Difference
Blend

00:00:00:00

Top and Bottom (frue
Side by Side

Top and Bottom

The “Swap Left/Right” check box works in combination with all following
modes that display both channels. It swaps the input channels and should

therefore normally be unchecked.
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The first group of modes only displays one channel at a time.

The second group of modes lists several common anaglyph filters that can be
used with widely available anaglyph glasses.

The third group contains a range of modes, most of which spatially interleave
both channels or place them next to each other. Especially the side-by-side and
top-and-bottom formats are common for addressing 3D displays.

Finally, Quad Buffered Stereo delivers the highest-quality 3D effect as it
provides synchronous double-buffering for each eye. This option is only
supported by professional graphics devices and therefore not always available.

In order for this option to be available the graphics device needs to support
Quad Buffering and stereo needs to be enabled in the graphics device control
panel as well as in the easyDCP Player video options pane. When this option is
selected in easyDCP Player, the graphics driver control panel is also the place to
configure how exactly left and right images should be output. Common
choices are output for shutter glasses or Dual-DVI stereo, e.g. left images over
one DVI output and right images over the other DVI output. easyDCP Player
simply passes left and right images at full resolution to the graphics driver.

5.13 30 Bit Colors via DisplayPort

By default, images are displayed with 8 bits per color (also referred to as 24

bit). Beginning with version easyDCP Player+ 1.8, 30 bit output can be enabled
PLUSFeature (10 bit per color), provided both the primary graphics device and the display

support 10 bit per color and the display is connected with a DisplayPort link.

Open
Playback

Log Ctrl+L

Options o

2D13D

Color Transforms

De-Interlacing

Asset

View Fullscreen

Content Decryption v Show Canvas

Help
Exit Alt+Q Show FPS Stats

Show Drop Frames
Show Time Code

Show Source Info

This option can be enabled in the main context menu’s “View"” submenu. The
“30 Bit Colors” option is only selectable, if the hardware requirements are met.
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6 Export

easyDCP Player+ allows exporting a source’s video, audio or timed-text assets.
PLUSFeature The individual video frames can be unwrapped and saved as JPEG 2000 images
(*.j2c) or decoded to uncompressed DPX, uncompressed TIF or a QuickTime
container using any of the available installed QuickTime codecs. When
exporting decoded images, various image processing options can be applied.

BB Exporter =

Export to Directory. C\DCP_exports

O Unwrap DCP and create easyDCP project

© Export sequence

File Name Prefix expori_
@ Export from Frame 0 to Frame
O Export from Reel to Reel
B Video
Stereo Mode
Resolution Level
File Format
Codec 4000 kbit's
/L etterboxing
Color Transformation
¥ RGB (ITU-R BT.709 Full-Range)
Color Depth
Chraol
Bum additional offset from bottom

Bum in Timecode A offsetfrom botiom

Burn in Text AA offset from bottom

& Audio
File Format QuickTime
Codec MPEG-4 HEAAC

Advanced Settings Export

Unwrap whole DCP: easyDCP Player+ can simply unwrap the whole DCP
track file by track file. It will automatically generate an easyDCP Creator project
file, which can be opened with easyDCP Creator to generate a new package.
Regenerating the exported DCP will be almost as fast as a copy operation since
image files are already in the proper format and a time-consuming JPEG 2000
compression is not necessary. Just make sure that easyDCP Creator is
configured to (1) disable JPEG 2000 re-encoding, (2) disable automatic pillar-
/letterboxing, (3) bypass the video track files’ color transform. This option
requires that keys were ingested for all compositions as it will unwrap the
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whole package. When extending an existing package, e.g. by adding subtitles,
this option should usually be preferred over the “Export sequence” option.

Create supplemental project: This option is only available if external subtitles
were loaded. Exporting in this mode will create a easyDCP Version File (VF)
project file to be opened by easyDCP Creator. The project will reference all
track files from the original package. Any externally added subtitles will be split
into reels and converted to SMPTE or Interop, when necessary. During the
conversion, any subtitle attributes that use the default values defined in the
specifications will be stripped.

Export Sequence: This option can also be used to export a package’s content
into image and audio files. However, it will skip the reels’ invisible frames, e.g.
when the movie has a run-in. To work around this, it is also possible to load a
package’s MXF files individually and unwrap those one by one. This is
effectively what the “Unwrap whole DCP” option does.

In- and Out-Points: Start and end points can be specified in terms of frame
indices or reel indices. Exporting reels comes in handy when creating proxy file
sequences to be used during the subtitling process, because subtitle files have
to be provided individually for each reel.

Stereo Mode: A stereo package’s left and right channel will be exported
individually. Creating a stereoscopic QuickTime video is not supported.

Resolution Level: JPEG 2000’s scalability by resolution can be utilized to
export proxy sequences.

File Format: JPEG 2000 (unwrap only), DPX, TIF or QuickTime. “Check (decode
only)” is a quality assurance feature. It will decrypt and decode all frames in the
package as fast as possible, verifying that the JPEG 2000 files are decodable,
contain the proper profile flags and don’t violate the maximum bitrate assigned
to the asset (250 Mbit/s by default).

Codec: When exporting to QuickTime, any of the installed QuickTime codecs
can be selected (Audio and Video).

Scaling/Letterboxing: \When exporting to QuickTime, the source can
optionally be scaled and/or letterboxed. When enabled, the image will be
scaled until either the width or height matches the desired resolution. If the
output aspect ratio is different from the source, the remainder will be letter-
/pillarboxed.

Color Transform: Any of the XML-based color transforms can be applied
during the export. Please note, that this will impact the decoding performance.

Color Depth: For DPX, bit depths of 8, 10 and 16 bits as well as the native bit

depth can be selected. Choose 10-bit for the highest compatibility with other
tools. For TIFF, bit depths of 8 and 16 bits as well as the native bit depth can be
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selected. Export to QuickTime is restricted to 8 bits or 16 bits per color. The
option to export to QuickTime in 16-bit mode will only be present when the
source material actually exceeds a bit depth of 8 bits.

Chroma Subsampling: When exporting chroma-subsampled source material
(i.e.in 4:2:2 or 4:2:0 configurations) to DPX or TIFF, 4:4:4 or the native
subsampling scheme can be selected. In case 4:4:4 is selected, the video
material will be upsampled accordingly.

Burn-In Subtitles: Any of the present timed-text tracks can be embedded into
the image. Optionally, the subtitles’ original positions can be shifted vertically.
This comes in handy when creating new subtitles: a proxy file with the original
subtitles burnt-in can be provided to the subtitler, who can add a new
translated subtitle track and position it comfortably.

Burn-In Timecode: Allows to burn in the time-code.

Burn-In Text: Allows to burn in a static text, e.g. “Property of Fraunhofer”.
Clicking the “...” button, will pop up an editor dialog that provides more
space.

File Name Prefix: Will be used as the base file name.

Audio: Audio essence can be stored as a single multi-channel WAV file,
multiple single-channels WAV files or a in a QuickTime container. When the
target wav-file exceeds the limit of 2GB file size, it will be split into multiple
files. If both audio and video essence is exported using the QuickTime format,
data will be interleaved into a single container file. Please note that depending
on the selected codec, not all audio channel layouts might be supported.
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7 Quality control

Before distributing a DCP or IMP, it is highly recommended to run both the
hash check and the decode test (both explained below). When running these
tests, the package should be loaded not from the local drive, but directly from
the mobile hard-drive.

71 Log/Issue Reports
When a new asset is loaded, easyDCP Player automatically executes numerous

checks, identifying potential issues related to integrity, formatting and security.
The results are collected and presented to the user in a log window.

Log @

Info Warning Error Save As 0O auto-appear

Code Timestamp

¥ Loading new project...
* Loading Package from "M:/Forma

¥ML nodes encountered (...

PIDCP subtitles with

The user should always read the error or warning messages very carefully.
Issues are presented in a hierarchical tree. Typically, the lowest level contains
the most detailed error message. The bottom half of the window shows all
details of the highlighted issue. Each log entry has a severity level: Info,
Warning or Error.

Info: Feedback to the user or general log entries are classified as infos.

Warning: Issues that might result in the DCP/IMP not working on some
servers, but that easyDCP Player can still cope with are classified as warnings.

Error: If easyDCP Player cannot continue to process the asset, an issue is
classified as an error.

The whole log can be saved as a *.HTML or *. XML file using the “Save As”
button in the tool bar. When turning to the easyDCP technical support with a
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guestion regarding a specific issue listed in the log, please attach the file.

By default, the log window appears, whenever a new Warning or Error was
added to the log. By disabling the “auto-appear” checkbox in the top right
corner, the window will be kept hidden until it is manually popped up using the
context menu->Log Window option (or press G). Disabling the auto-appear
option is not recommended.

The MXF hash values are not checked automatically, since this would be too
time consuming. Please refer to chapter 7.4 for details on how to apply a hash-
check on a single package or the whole playlist.

7.2 Decode Test

ﬂ Exporter @‘

Export to Directory: C\DCP_exports

O Unwrap DCP and create easyDCP project
@ Export sequence

File Name Prefix
© Export from Frame 0 toFrame 3123

O Export from Reel to Reel
Resolution Level
File Format C ecode only)

Letterboxing

ansformation
Color Depth

O Audio

Advanced Settings Export  Close

The export module can be used to decode all audio and video frames as fast as
possible to verify their integrity by selecting the output format “Check (decode
only). In order to detect errors in any part of the codestream, run this test using
the full resolution.
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By default, log files can be created for each export, containing an entry for
every successfully decoded frame. This can be disabled by editing the settings
file:

[dummyexport]
write_log_file=true

7.3 Metadata Inspector

The Metadata Inspector can be opened via “context menu->Asset->Metadata
Inspector” or by pressing “I” on the keyboard. It gives information about the
current asset’s general properties as well as audio- and video-specific
properties. Each field is explained in its tool tip. The video properties
“Resolution” and “Bit Depth” contain data that is listed individually for each
color component (for DCPs they are always identical).

Additionally, the same information is available by clicking on O nextto a
playlist item.

Metadata Inspector @

* Asset

Property Value

FHG_INT_OV

* Video

Property Value
Components
Resolution

Bit Depth

Quality

Resolution Levels

Edit Rate

* Audio

Property Value

17616
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7.4

File Hash Checker

When loading a package, easyDCP Player will validate file sizes of all files.
However, it will only validate the XML files” hash values. A file hash validation
of the remaining files in the package has to be manually triggered by the user
since it takes too long to be done automatically, especially for large files. Before
distributing a DCP/IMP, the hash values should be checked. To do this, it makes
sense to load the package directly from the mobile hard drive. Select “Check
File Hashes” in the context menu or press “H”. If a package has been loaded,
all asset files and their reference hash values will be listed. Click “Check
Hashes” to start the hash value calculation. To make the hash check available
for encrypted DCPs without requiring content keys to be loaded, the “Playlist
Editor” Dialog also has a button that opens the “Check File Hashes” dialog.

Hash Check =)

File Size  Size Calculated Hash Execute Check?

Simultaneous Checks: 4 : Check Hashes Cancel

In order to calculate hash values for arbitrary other files, drag & drop the file
into the “Check File Hashes” dialog.

A hash value validation succeeds if the calculated hash value is identical to the
reference hash value listed in the DCP/IMP. The “status” column will then
display a green “Ok".

easyDCP Player also has a command-line parameter to perform the hash check.
Please refer to chapter 10.
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7.5 Audio Waveform Visualizer

This module visualizes the audio tracks of the currently opened assets. In can be
used to mute individual channels in order to check if the channel order is
correct. The white cursor represents the currently showing frame and by
aligning it to a peak in the waveform, audio-video-sync issues can be identified
conveniently.

In cases where easyDCP Player(+) was unable to read correct channel labels
from the asset, it will show “Channel X" instead.

Waveform Visuslizer =]

¥ Channel 1

¥ Channel 2
¥ Channel 3

¥ Channel 4

Solo Channel
v Mute Channel

Unmute All

Collapse Others

~ Channel 5 Expand Others
el5

1 1 1 | 1 1 | 1 | | 1 | | 1 | |
00:40  00:41 0042 0043 0044 0045 0046 0047 0048 0049 0050 0051 00:52 00 53=| 00:54 00:55 00:56
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8 Preferences

8.1 Preferred Video Codec

& Use Nvidia CUDA JPEG 2000 Decoder

This option is available in the Windows version only. Both easyDCP Player and
easyDCP Player+ come with two JPEG 2000 decoders.

The GPU-based codec outsources the computationally expensive JPEG 2000
decompression to a secondary graphics device. It allows real-time playback
even on low-end computers as it does not heavily use the CPU.

The software-only codec decodes images using only the CPU. It is not
dependent on a special graphics device. This codec automatically detects the
number of CPU cores and utilizes them all for optimal performance. On low-
end computers (e.g. dual core) it will not be able to playback DCPs/IMPs at full
resolution in real-time. On high-end computers with many CPU cores, however,
it is even able to playback stereoscopic 2K@48fps packages in real-time.

In the options dialog, you can setup which codec should be used by changing
the “use Nvidia CUDA JPEG 2000 Decoder” option.

8.2  Video Rendering

easyDCP Player employs multiple advanced video rendering technologies, that
are both platform and hardware dependent. The settings found in the options
dialog’s “video” pane merely influence if easyDCP Player requests these
features. If they are actually available on the system can be seen in the easyDCP
Player system info dialog (Press F10).
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PLUSFeature

PLUSFeature

ﬂ Options &J‘

Video
General Renderi
Audio General Rendering

[ V-Sync ™ (currently on)

Subtitles
O 30bit colors *  (currently off)

O Quad-Buffering * {currently off)

ake effect after restarting the program.

App
Background Color:

Rendering

0K Cancel

Vertical Sync (V-Sync): This option should only be enabled, if the video
rendering suffers from tearing artifacts. Enabling V-Sync will typically negatively
impact the render performance.

30 bit colors: (easyDCP Player+ only). Also, Mac OS X does not support 30 bit
rendering. In order for this option to be available, both the graphics adapter
and the display need to support it. Within easyDCP Player+, 30 bit rendering
additionally needs to be enabled or disabled with the corresponding option in
the “View"” menu, e.g. “context menu->View->30 bit Colors”.

Quad-Buffering: (easyDCP Player+ only). Also, Mac OS X does not support
Quad Buffering. Quad Buffering is available, if the graphics adapter supports it
(e.g. NVIDIA Quadro® series) and stereo is activated in the driver settings.
When active, left and right images of a stereo source are both passed at full
resolution to the graphics driver. Within easyDCP Player+, Quad Buffering
additionally needs to be enabled or disabled in the “2D/3D” menu, e.qg.
“context menu->2D/3D->Quad Buffering” or alternatively by pressing the
corresponding button in the control bar.

Background Color: This button allows to pick a custom color for the video
canvas in order to determine if an asset contains black pillar- or letter- boxes.

V-Sync Rendering: Since v3.0 easyDCP Player has two render modes: V-sync-
independent rendering and V-Sync-rendering.

V-sync-independent rendering: This was the only option in all versions prior to

v3.0. It is still a good choice if the display runs with 60 Hz or more. It is also the
fallback option, if V-Sync rendering is not available or not enabled.
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V-Sync-rendering: Especially, if the target display is a LCD-TV or a projector, or
if the maximum refresh rate is significantly lower than 60 Hz (e.g. only 30 Hz),
then the V-Sync rendering mode should be selected. It can be activated in
Options->Video->V-Sync Rendering (only available if Options->Video->General
->Rendering->V-Sync is “currently on”). Even if V-Sync was requested, the
driver might not enable V-Sync due to other conflicting settings in the graphics
driver control panel. When you start playback in V-Sync-Rendering mode, the
package's frame rate as well as the display's refresh rate will be started in curly
brackets next to the "Render" fps line (e.g. "Render (24 fps @ 24 Hz) in the
statistics window. easyDCP Player will now explicitly translate between the
package's frame rate and the display's refresh rate, which gives best results
when both rates are equal or when the display's refresh rate is an even multiple
of the package's frame rate.

Hint: When using two Nvidia graphics cards (e.g. one for rendering and one for
decoding with CUDA), it might be necessary, to manually specify the graphics
card that will be rendering: NVIDIA Control Panel->3D Settings->Manage 3D
settings->Global Settings->OpenGL rendering GPU-> <select the graphics card
that drives the display where easyDCP Player's canvas is located>. This can
make a significant difference in terms of render performance.

8.3  Audio Rendering

Both easyDCP Player and easyDCP Player+ support multi-channel output. By
default the audio output device that supports most channels will be selected.
Open the audio options pane (context menu->Options->Audio tab) for a list of
all available audio renderers. Supported interfaces are DirectSound (Windows),
MME (Windows), ASIO (Windows) and CoreAudio (Mac OS X).

' Cptions B3

Output Device 2 channels - Lautsprecher (Realtek High Defi W

O Lossless audio output

& Automatic Stereo-Downmix
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Latency: It is possible to specify a latency in milliseconds for each renderer. This
latency will be taken into consideration when synchronizing audio and video
frames. Changing the latency will take effect immediately, so it can be easily
tweaked while simultaneously watching a test package. Except for HD-SDI
output, the latency should normally be positive, i.e. video output will be slightly
delayed to compensate for the latency introduced by the operating system'’s
audio processing pipeline.

Lossless audio output: \When this option is active, audio samples are passed
to the audio renderer in their native sample format without applying any
volume control or a downmix. Using a ASIO driver and a sound adapter with a
digital output, samples are passed-through losslessly.

Automatic Stereo Downmix: Select this option to downmix 5.1 sound to
stereo.

Audio routing: The audio channel order is retrieved from the input MXF
Sound Track File, if possible. If the audio channels are not labeled in the Track
File at all, a default channel order is read from the easyDCP Player settings file.
A default output order is read from the settings file as well. For more details,
please refer to chapter 10.

8.4 HD-SDI Play-out

PLUSFeature

& Enable HD-SDI output
Device DeckLink DI

Mode HD 1080p 24 (1920

Color Depth 24 Bit YUV 4:2:2

Levels Automatic

Locations O Show video alsoin canvas

& Enable subtitling, color-processing and scaling

0 Enable HD-SDI video frame statistics

Enable HD-SDI output: Since version 2.0, easyDCP Player+ is capable of
playing out HD-SDI with the Blackmagic Design UltraStudio and DeckLink
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series. Both, PCle-connected cards and Thunderbolt-connected external devices
are supported.

Thunderbolt devices will only be detected, if they are attached at the time
easyDCP Player+ is started. When enabling HD-SDI output within easyDCP
Player+, the audio output device should be “ASIO (<name of HD-SDI device>)”
on Windows and “CoreAudio (<name of HD-SDI device>)" on Mac OS X, so
that audio and video signals emitted via HD-SDI are in sync. ASIO drivers for
Windows are available for download at www.asio4all.com. The audio latency
should normally be negative.

Advanced HD-SDI related settings can be configured in the Blackmagic Design
Control Panel.

Output mode: Select a HD-SDI output mode. The frame rate is required to be
identical to that of the currently playing package. When playing back multiple
DCPs or IMPs with different frame rates back to back, the HD-SDI output is not
automatically adjusted. If the resolution is smaller than the package’s resolution
and “Enable subtitling, color-processing and scaling” is disabled, images will be
cropped. On the other hand, if the resolution is larger and the processing
option is disabled, images will be pillar-/letterboxed.

Color Depth: Sets the bits per component.

Levels: Select whether to apply a legal range conversion or not. “Automatic”
will apply a conversion, if the output format requires it. Alternatively, you can
select “Convert full-range to legal-range” to enforce the conversion or “No
conversion” to always skip it.

Show video also in main window: Displaying video in the main window
while HD-SDI output is active will impact the render performance and might
lead to stuttering. Enable this option with care. (Enable the statistics from
"context menu->View->Show FPS stats”)

Enable subtitling, color-processing and scaling: If this option is enabled,
images will be scaled to meet the currently set-up HD-SDI output resolution.
Additionally, the currently selected color transform will be applied and subtitles
will be rendered. This option has significant impact on the render performance.
(Enable the statistics from “context menu->View->Show FPS stats”)

Enable HD-SDI video frame statistics: This option should normally be
disabled.
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8.5

Subtitles

' Cptions B3

O Closed Subtitle
O Open Caption
O Closed Caption
O HNo Subtitles

Subtitle Rendering
& Render subtitie outlines

OK Cancel

Default Visible Subtitles: A composition may have one or more timed-text
tracks. Select here which track shall be rendered.

Subtitle Rendering: On some systems, subtitle outlines are not anti-aliased.
This effect is noticeable, when multisampling is not enabled. Whether or not
multi-sampling is enabled can be seen in the easyDCP Player system info dialog
(Press F10). On Windows, disabling “Allow 30 bit colors” and “Allow Quad-
Buffering” might lead to multi-sampling becoming available. Alternatively,
outlines can simply be ignored by enabling the option “Do not render
subtitle outlines”.

Servers behave differently, when it comes to rendering PNG sub-images.
Toggling the option “Include PNG Subtitles in Color Transform” specifies if
sub-images should also be included in a color transform, i.e. XYZ to RGB, or
not.
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8.6

Software JPEG 2000 Codec

' Cptions =
Performance Quality

O Make 4K resolution level available

& lgnore codestream errors, if possible

Max bitrate violation tolerance: 0 Byles

Locations

OK Cancel

Performance vs. Quality trade-off: Since version 2.0, easyDCP Player is
capable of trading some decoding precision for a better performance.
Especially, when viewing DCPs/IMPs (which have 12 bit per color) on a regular
24 bit monitor, some information from the JPEG 2000 codestream can safely
be ignored without significantly impacting the resulting image quality.

The algorithm is designed in a way that the trade-off does not have to be re-
configured for every package. At a certain position, codestreams from a
DCP/IMP that contain so many details that they fully utilized the maximum
available data rate might already be truncated. When subsequently loading a
package that has only a low data rate, because it does not contain many
details, the precision would not be impacted, however, because it has a low-
rate to begin with. This is desirable, because the performance requirements for
decoding a low-bitrate package is much lower, anyway.

Make 4K resolution level available: By default, 4K assets are loaded in a
way that only a maximum resolution of 2K is available, mainly to save memory
and lower the performance requirements. Since many displays are not capable
of rendering 4K anyway and 4K playback has much higher demands on
memory and hardware, only the 2K part of a 4K JPEG 2000 codestream is
evaluated. A 4K DCP or IMP can also be opened in full resolution by enabling
this option. Smooth playback requires much more hardware resources and is
not guaranteed.

Ignore codestream errors, if possible: Being a software-quality tool,

easyDCP Player aborts playback as soon as a corrupt JPEG 2000 codestream is
encountered. This option controls the decoder’s error resilience mode.

47 of 70 22/10/2015



Maximum bitrate violation tolerance: Unless error resilience is enabled,
easyDCP Player also checks if the limit is met. Some packages in the field
slightly violate this limit by a few bytes, which does not seem to cause any
playback issues on D-Cinema servers. To avoid warning messages in easyDCP
Player, the limit should be slightly raised. The default is O bytes.

8.7 GPU-based JPEG 2000 Codec
This codec is not available in easyDCP Player for Mac OS X.

Performance Quality

0O Make 4K resolution level available

O Ilgnore codestream errors, if possible

Max bitrate ation tolerance: 120 Bytes

OK Cancel

The options “Performance vs. Quality trade-off”, “Make 4K resolution
level available.”, “Ignore codestream errors, if possible” and “Max
bitrate violation tolerance” are identical to those in the Software JPEG 2000
Codec configuration pane (8.6).

For playback of DCPs in real-time in GPU-based mode, easyDCP Player requires
a bundle of two graphics devices - a primary device for rendering and a
secondary device for video decompression. Refer to chapter 3 for more details
on the system requirements.

On most systems, easyDCP Player is able to automatically configure itself. It
attempts to use only the secondary device’'s GPUs for JPEG 2000
decompression and ignore the primary GPU as it will be used for rendering.

The options pane contains a list of all GPUs reported by the OS and a list of
GPUs that support the NVIDIA® CUDA® technology. NVIDIA® CUDA® is a
technology that allows to execute calculations - in the case of easyDCP Player
the JPEG 2000 decompression - on the graphics device. Therefore, if the
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primary device supports the NVIDIA® CUDA® technology, easyDCP Player
needs to ignore it, i.e. not use it for JPEG 2000 decompression. If the primary
device does not support the NVIDIA® CUDA® technology, easyDCP Player
should use all CUDA-enabled devices it finds for JPEG 2000 decompression.

In the screenshot above, the primary device is the NVIDIA Quadro® K600. Even
though it does support the NVIDIA® CUDA® technology, it must not be used
as a CUDA device, because then decoding with CUDA and rendering with
OpenGL would get in the way of each other, which leads to heavy stuttering.

If you play back a video asset with the GPU-based codec, hit ‘s’ to display
the performance statistics. The bottom line usually needs to read “GPU
Decode (1x GPUs)" (unless the CUDA device has two cores like in the
screenshot above. Then it should be “2x GPUs"”). Do not enable a CUDA
graphics card marked with “(connected to display)”

The CUDA-enabled decoder is only available in the Windows version.
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9 Content Decryption

9.1 Server Certificates

PLUSFeature

easyDCP Player+ allows playing back encrypted content. Each Digital Cinema
play-out system or mastering station has its own private key and public key,
and so does each easyDCP Player+ installation. The private key is known only to
the play-out system, whereas the public key is contained in a public server
certificate and may be distributed to content providers. When content providers
choose to encrypt a DCP, they need to somehow provide the decryption keys
(there is one key for every encrypted track file) to the play-out system. To
ensure that no one else is able to read these sensitive decryption keys, they are
themselves encrypted in a way that only the targeted play-out system is able to
decrypt them. To do this, the content provider will need the play-out system’s
public server certificate. This encrypted message is called a Key Delivery
Message (KDM). easyDCP Player+ will keep all ingested KDMs in a repository
(key repository subfolder in easyDCP Player+ application data folder. See 4.8) so
that encrypted DCPs can be viewed multiple times without having to re-ingest
the keys each time. KDMs will not be removed from the repository after they
expired, but an expired KDM will no longer grant access to the DCP.

When easyDCP Player+ is first started, it does not yet have a server certificate
set. The demo edition does not allow playback of encrypted content. Only in
the commercial edition, server certificates can be requested from Fraunhofer
support by clicking “context menu->Request License & Certificates”. The
process is described in a screen cast at www.easydcp.com.

Unique private and public keys will be generated and provided to you online.
The received license and certificate set (a Zip file) can be imported via drag &
drop (or with , context menu->Help ->Import License & Certificates”.

The certificates are created and signed by Fraunhofer IIS. Fraunhofer IIS will
delete the private key immediately, and keep the public leaf certificate in a
database. The certificate is digitally signed by a chain of Fraunhofer certificates.
These certificates are referred to as a certificate chain and this certificate chain,
even though already included in the public server certificate, is additionally
saved in a separate file. These certificates are meant for commercial use as they
state the licensee’s URL and have a unique serial number that links the
certificates to the license. These server certificates are tied to the licensee’s
computer, using the easyDCP system hash. If the license should need to be
migrated to another system, a new certificate set will have to be requested. A
migration is possible in the user account at www.easydcp.com. Since the
private key is very sensitive, it is asynchronously encrypted using a combination
of easyDCP Player internal keys and a password selected by the user during the
License & Certificates request. Likewise, if the user chooses to store their
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password, it is first asynchronously encrypted. The user password needs to have
6 to 20 letters and cannot be changed after it was created.

All mentioned files are stored in the user application data folder’s certificates
subfolder (see 4.8). Hence, the OS user management can be used to maintain
multiple sets of certificates simultaneously. In order to easily determine which
files belong together, they are each identified by a unique ID. The ID of the set
that is currently used by easyDCP Player+ is also listed in the “About” dialog
(hit 'F6").

e easydcpexport_<ID>.privkey.pem contains the encrypted private key
e easydcpexport_<ID>.cert.sha256.crt is the public server certificate
e easydcpexport_<ID>.chain.sha256.pem contains the certificate chain

e easydcpexport_<_<ID>.privkey.passwd contains the encrypted user
password

When easyDCP Player+ is uninstalled, none of these files will be removed. If the
user password file (*.passwd) is manually deleted, the user will simply be
prompted for the password again the next time a KDM is ingested or an
encrypted DCP is opened.

On demand, we can also offer the easyDCP Player+ NE edition, where “NE”
stands for “No Export”. It contains all the features of easyDCP Player+ except
for the export. It's certificate prefix (stated in the filename as well as in the
certificate itself) is “easydcpnoxport_" as opposed to “easydcpexport_". This
way, content owners easily distinguish which edition they issue a KDM for.
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9.2 KDM Management

Open
PLUSFeature Playback

Log
Options

20130

Color Transforms

De-Interlacing
gset

Wiew

Content Decryption Ingest Content Keys... A |
Export Public Server Certificate... F7

Help
Exit Alt+C

|
Open Key Repository

The content decryption context menu is only available in the easyDCP Player+
edition.

“Ingest Content Keys” pops up a file browser and lets you ingest content key
files (Key Delivery Message or easyDCP Digest).

Drag & Drop: You can also ingest multiple Key Delivery Messages (KDM) or
easyDCP Digests by simply dragging & dropping them onto the canvas.

The option “Export Public Server Certificate” will copy both the public leaf
certificate (easydcpexport_<id>.cert.sha256.crt) and the signature chain
(easydcpexport_<id>.chain.sha256.pem) to the selected folder. The signature
chain contains the leaf certificate as well as intermediate certificates and the
root certificate. You may safely distribute these certificates to content providers
who want to issue a Distribution KDM to your easyDCP Player+ installation.
When issuing (D)KDMs with easyDCP KDM Generator, place only the leaf
certificate file (*.crt) into the server certificate’s folder or just drag and drop it
into the corresponding input form.

For a description of how to request your custom certificates, please refer to
chapter 4.6 (License Activation and Certification).

For more details on the decryption workflow, please refer to chapter 9
(Content Decryption).
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The option “Open Key Repository” opens the key repository in a Windows
Explorer / Finder window. All ingested Key Delivery Messages (*.xml, *.kdm)
and easyDCP Digests (*.dcpdig) will be stored in this folder and renamed
according to the contained CPL UUID (digests with keys for multiple CPLs are

duplicated). Expired key files can be deleted from here manually when easyDCP
Player is not running.
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10  Audio Routing

Different mechanisms are used to identify audio channels carried in MXF Sound
Track Files within Digital Cinema Packages (DCP) and Interoperable Master
Format (IMF) Packages. Playback systems rely on such information for
eventually outputting sound to connected loudspeaker setups.

This chapter describes configuration options for easyDCP Player 3 and explains
routing mechanisms for different package types.

10.1

10.1.1 Interop DCPs

Audio Channel Identification

Interop DCPs usually don’t carry explicit audio channel configuration

information. The Inter-Society Digital Cinema Forum (ISDCF) recommends the
channel layout specified in Table 1. Theater operators rely on the optional use
of the Digital Cinema Naming Convention [5] in order to identify the channel
layout correctly. See [8] for more details.

Table 1 - Recommended Audio Channel Assignments for Interop DCPs

Channel 5.1 7.1 SDDS 7.1 DS Speaker Position

1 L L L Left

2 R R R Right

3 C C C Center

4 LFE LFE LFE Low Frequency Effects

5 Ls Ls Lss Left Surround (Left Side Surround)

6 Rs Rs Rss Right Surround (Right Side Surround)
Hearing impaired (with emphasis on

7 HI :
dialog)

3 VIN Visua!ly .impaired narrative (audio
description)

9 - Lc - Left center

10 - Rc - Right center

11 - - Lrs Left rear surround

12 - - Rrs Right rear surround

13 Motion Data Synchronous signal (e.g. used by D-
Box)

. Used for external sync — not used for

14 Sync Signal Interop DCP y

15 - Unused

16 - Unused
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10.1.2 SMPTE DCPs

Most of today’s SMPTE DCPs use an audio channel assignment label in the
Sound Track File metadata to identify the audio channel order in the file.
SMPTE ST 429-2 [1] describes five different configurations, which can be
identified by the associated label:

1. 5.1 + HI/VI-N

2 6.1 + HI/VI-N

3. 7.1 SDDS Layout + HI/VI-N

4. 16 Channels “Wild Track Format” (WTF)

5

7.1 DS Layout + HI/VIN

Table 2 - Standard Audio Channel Assignments for SMPTE DCPs

Channel 5.1+ 6.1 + 7.1 SDDS | Wild Track | 7.1 DS +
HI/VI-N HI/VI-N + HI/VI-N Format HI/VI-N
1 L L L CH1 L
2 R R R CH2 R
3 C C C CH3 C
4 LFE LFE LFE CH4 LFE
5 Ls Ls Ls CH5 Ls
6 Rs Rs Rs CH6 Rs
7 HI Cs Lc CH7 Lrs
8 VI-N not used Rc CHS8 Rrs
9 - HI HI CH9 HI
10 - VI-N VI-N CH10 VI-N
11 - - - CH11 -
12 - - - CH12 -
13 - - - CH13 -
14 - - - CH14 -
15 - - - CH15 -
16 - - - CH16 -

Of course, not all DCPs actually contain HI and/or VI-N channels. Whether these
channels are present can be determined by taking the channel count into
account, which is also indicated in the Sound Track File metadata. For example,
config #1 (5.1 + HI/VI-N) combined with a channel count of “6", indicates that
no HI/VIN channels are present in the corresponding Track File. That being said,
some facilities add silent channels for missing HI/VI-N channels, which makes it
difficult to determine whether useful HI/VI-N channels are present, or not.

DCPs containing Dolby Atmos® [6] Sound Tracks require a sync signal added to
the “traditional” 5.1/ 7.1 Sound Track File. Since such a channel can only be
included in channel assignment #4 (WTF), the content of the remaining audio
channels present in this Sound Track File remains unclear.
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The 2013 version of SMPTE ST 429-2 [2] adds support for Multi-Channel Audio
(MCA) Labeling, which is defined in SMPTE ST 377-4 [3]. Sound Track Files
using this, contain a number of SubDescriptors in the Wave Audio Essence
Descriptor. These SubDescriptors, besides other things, identify and describe
every audio channel present in the MXF file and leave no room for ambiguity.

SMPTE 429-16 [4] defines a way to carry additional (machine-readable)
metadata in CPLs. Besides other things, sound configurations can be stored for
Sound Track Files that are referenced by the CPL in that metadata. While the
standard document was released in 2014, hardly any DCPs in the field include
this metadata as of today.

10.1.3 IMF Packages

According to SMPTE ST 2067-2 [7], Audio Track Files in IMF Packages are
required to use Multichannel Audio Labeling, as defined in [3].

10.2 Configuration and output behavior

Some adjustments can be made in easyDCP Player’s settings.ini file (see chapter
4.8 for location of file). Two entries influence audio channel routing:

e output channel order: specifies the local output layout (e.g.
speaker setup)

e fallback input channel order: used if no audio channel
configuration is signaled in the Package (InterOp/Wild Track Format)

Both entries have a default value that represents the 7.1 SDDS layout (Left —
Right — Center — LFE — Left Surround — Right Surround — Left Center — Right
Center). The output channel order value has to be adjusted to match the
local speaker setup, in case it uses a different layout.

[audio]

output channel order="L, R, C, LFE, Ls, Rs, Lc, Rc"

fallback input channel order="L, R, C, LFE, Ls, Rs, Lc, Rc"
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10.3

Behavior

The recognized channel symbols are listed in the following table.

Table 3 - Audio channel symbols for use in settings.ini

Symbol Description Package Type
L Left DCP/IMF
R Right DCP/IMF
C Center DCP/IMF
LFE Low Frequency Effects DCP/IMF
Ls Left Surround DCP/IMF
Rs Right Surround DCP/IMF
Lss Left Side Surround DCP/IMF
Rss Right Side Surround DCP/IMF
Lrs Left Rear Surround DCP/IMF
Rrs Right Rear Surround DCP/IMF
Lc Left Center DCP/IMF
Rc Right Center DCP/IMF
Cs Center Surround DCP/IMF
HI Hearing Impaired DCP/IMF
VIN Visually Impaired Narrative DCP/IMF
M1 Mono One IMF
M2 Mono Two IMF

Lt Left Total IMF
Rt Right Total IMF
Lst Left Surround Total IMF
Rst Right Surround Total IMF

S Surround IMF

If a Sound Track Files signals an audio channel configuration, this configuration
is taken into account. If not, the fallback input channel order isread
from the easyDCP Player settings file.

The output channel configuration is read from the settings file

(output channel order). If the number of channels, listed in settings.ini,
exceeds the number of channels actually supported by the selected output
device (e.g. soundcard), all channels exceeding this count remain unused.

If a package contains channels, for which there is no output channel
configured in the settings file, these channels are ignored and not played out.
Only exceptions are Lt/Rt channels, which can be used in IMF packages. If no
Lt/Rt output channels are specified in the settings file, they are routed to the
L/R output channels (if present).

In case stereo downmixing is enabled in easyDCP Players options menu, the
channels L, R, C, LFE, Ls and Rs are detected by the described mechanisms and
a downmix is played out on L/R.

The lossless audio setting in the options menu does not have any influence on
audio channel routing.
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10.4 Configuration and output examples

10.4.1 Using a standard 2.0/5.1 speaker setup

There is no need to change settings.ini at all, since the first entries of the
default configuration match a 2.0/5.1 speaker setup.

The diagram visualizes the internal process from DCP to loudspeaker:

DCP uses Wild

Track Format, so -~

">+ no explicit channel
assignment

DCP ’

fallback input

configuration from
settings.ini

internal input
channel
representation

(ehi:L

chi:L )

(ch2:R )

(ChzR
(ch3: C

(ch3:C -

Audio Channel Assignment Label: #4
ChannelCount: 6

(ch4:LFE

ch4:LFE )

ch5: Ls s

(ch5: Ls

ch6: Rs )=

(ché: Rs

output channel
configuration as
specified in
settings.ini
(ch1- L )=
chi: L

output channels

actually present
(offered by output
device)

C
ch2: R -

(ch1:L ———>)

C

CER_—>)

(ch3:C

(ch&:LFE

(ch3:LFE_ )—+——>)

ch4: C ——>)

(ch5:Ls

@B )

(ché: Rs

(ch6:Rs —1—>o)

The DCP Sound Track File contains the audio channel assignment label #4,
which indicates “Wild Track Format”. Since this configuration does not specify
a discrete channel layout, the fallback input configuration from the settings file
is used for the number of channels present in the Sound Track File.

The input channels are then routed to the matching output channels, as

specified in the settings.ini configuration file.
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10.4.2 Fixing swapped channels

Let’s assume the Center channel and the LFE channel are mixed up in your
output device. In that case, output channel order needs to be changed

in settings.ini (see chapter 4.8 for location of file). The following line will

internally switch these channels:

output channel order="L, R, LFE,

C, Ls,

Rs, Lc, Rc"

The diagram visualizes the internal process from DCP to loudspeaker:

internal input output channel output channels
channeF configuration as actually present
representation specified in (offered by output
P settings.ini device)
CIHD (chi:L ) (chi:L  1+——>)
(ch2R— > CED) (ch2R _ —1——u)
DCP ch3: C L >(ch3:LFE (ch3:LFE )———>u()
| (ch4: LFE ECHD' (chaC_ r+—>)
Audio Channel Assignment Label: #1 “(ch5: Ls D) ch5: Ls (ch5: Ls >_ﬁ.‘,))
ChannelCount: 8 —
(ch6é:Rs_ ) (ch&:Rs_ > (ch&:Rs_ ——>«)
ch7: H —
...................... | (chBVIN
No output channels e -

. setup for HI/VI-N in
- settings.ini, so they

The DCP Sound Track File contains the audio channel assignment label #1,
which indicates a 5.1 + HI/VI-N channel layout. Internally, the eight contained
channels are then being labeled accordingly.

HI/VIN are not further processed by easyDCP Player, because these channels are
not listed in the output channel configuration entry in settings.ini.
They are therefore not routed to any output channel. The remaining input
channels are routed to their matching output channels. So, in the case of the
center channel, input channel “C” (channel #3) is routed to output channel
“C" (channel #4).

59 of 70 22/10/2015



10.4.3 IMF Package 5.1 + HI/VI-N

Conditions: IMF Package containing 5.1 + HI/VI-N, 7.1 loudspeaker setup
connected to computer, default output channel configuration in settings.ini.

Since no HIVI-N output channels are defined in settings.ini, the HI/VIN tracks
are ignored and only 5.1 is sent to the loudspeakers.

This behavior is identical for SMPTE DCPs that use the audio channel
configuration label #1 to identify the contained sound tracks as 5.1 + HI/VI-N.

IMF

using MCA labeling

settings.ini, so
these channels are

<{ch7:C
ch8: HI

TN
internal input

channel
representation

PSR
output channel

configuration as
specified in
settings.ini

P
output channels

actually present

7chl: L )

—(haL Y|

ch6: VI-N

annels . )

setup for HVI-Nin 7

(ch1: L —

(ch2: R )

(ch2: R —

@EC

(@3:C D

N\(ch4.LFE_)

(ch4.LFE  )—

(ch5: Ls )
=(ch6: Rs )

(ch5: Ls —

(ch6: Rs —

(ch7: Lc )
(ch8: Rc )

(ch7: Lc i )

| —
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10.4.4 IMF Package Lt/Rt (default configuration)

Conditions: IMF Package containing Lt/Rt channels only, stereo loudspeaker
setup connected to computer, default output channel configuration in
settings.ini.

The default output configuration in settings.ini does not include Lt/Rt channels.
In that case, Lt/Rt is send to the L/R output channels and played out on the
connected stereo loudspeakers.

internal input output channel ) output channels
channel configuration as actually available
representation specified in
settings.ini
IMF (chi:L ) Ghi:L_ )t+—=>)
@z D @RZR D>
using MCA labeling ch2:R ch2:R )
—
\_ Y, S ch4:LFE
.....
No specific Lt/Rt
channels are J
specified in S
settings.ini, so L/R  /
will be used )
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10.4.5 IMF Package Lt/Rt (custom configuration)

Conditions: IMF Package containing Lt/Rt channels only, 16 channel sound
output device, custom output channel configuration in settings.ini (see chapter
4.8 for location of file):

output channel order="L, R, C, LFE

Lr, Rt"

Ls, Rs, Lc, Rc, , ,

~

14 14 14 14

The custom output configuration in settings.ini does include Lt/Rt channels that
might be hooked to a separate pair of stereo speakers. In this case, Lt/Rt is send
to the Lt/Rt output channels (15/16

~

IMF

using MCA labeling

( output channel ) ( output channels )
configuration as actually available
specified in
settings.ini
ohe:
V|
|| @ D> (@IEE D @IE D ——>)
(2Rt ——>(@hTE Rt D> TRt D——>+)
g J - ) \ J
J
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11 Command-Line Interface (CLI)

easyDCP Player can be used on the command line to perform a hash-check on
a package. easyDCP Player+ additionally provides all options required to export
a package. For detailed descriptions of the available parameters, call the
executable file with the parameter “—help”.

C:\Program Files (x86)\Fraunhofer IIS\easyDCP Player\bin>"easyDCP
Player+.com” -help

Usage: easyDCP Player+.exe <source>

A source can be the path to a Package directory, CPL,

Assetmap, M3U Playlist, MXF, J2C or WAV file.

Individual audio and video sources need to be separated with a space.
When a KDM or digest is required to load the source, just provide it
seperated by a space.

Optional parameters:

-stats <statsfile.csv>

write fps performance statistics to a file.
-log <logfile>|CONSOLE

enable log and write it to a file or the console
-logqgt <folder>

enable log of QuickTime Helper processes and
write the logs to the given folder.
-hashCheck only perform hash check
-play start playback immediately

Export parameters:
--exportDirectory|-o <path to export directory>
Sets the export directory. The directory has to exist.
[-—exportType |-t Project|Sequence|Reel]
Select export type:
Unwrap easyDCP project
Export a frame sequence
Export reels
[--exportFilePrefix|-p <export image prefix>]
Specify file prefix for image files or container file, e.g. "image ".
[-—exportVideo|-v DPX|TIFF|J2C|Check (decode only) |QuickTime]
Select image file format for export sequence.
[--exportVideoCodecPriority|-vcp GPU|CPU]
Set preferred JPEG 2000 video decoder:
hardware (GPU) or software (CPU) based.
If this parameter is not set,
the last saved setting is used as default.
[--exportAudiol|-a WAV |MultichannelWAV|QuickTime]
Select audio file format for export sequence.
[-—exportStartIndex|-from]
Set start of sequence, 0 is the default.
[--exportStopIndex|-to]
Set end of sequence, the last frame is the default.
[-—exportStereoMode|-c left|right|leftandright]
Select export channel for stereoscopic 3D assets.
[--exportRlvl|-rlvl]
Set number of resolution levels to be discarded.
Default is 0 for full resolution.
[-—exportColorDepth|-bps 8110]12]16]
Select color depth 8, 10, 12 or 16. Default is the original color depth
of the video asset.
[-—exportColorTransformation|-ct]
Set the color transformation.
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Default is no color transformation.
"Brighter for Shutter Glasses"
"X'y'z' -> R'G'B' (P3)"
"X'y'z' -> R'G'B' (Rec BT.709)"
"X'Y'Z' -> R'G'B' (Rec BT.709) (Brighter for Shutter Glasses)"
"X'Y'Z' -> R'G'B' Legal Range (Rec BT.709)"
"Y'Cb'Cr' Full Range -> R'G'B' Full Range (Rec BT.709)"
"Y'Cb'Cr' Legal Range -> R'G'B' Full Range (Rec BT.709)"
[-—exportVideoBitrate|-b]
Set the desired average video bitrate in kbit/s.
[--exportScaleX|-scaleX <width in pixels>]
Set scaled width in pixels. If aspect ratio is different,
the remaining pixels will be letterboxed.
[-—exportScaleY|-scaleY <height in pixels>]
Set scaled height in pixels. If aspect ratio is different,
the remaining pixels will be letterboxed.
[--exportFourCC|-fourcc <FourCC>]
Set one of the following FourCC codes for QuickTime video export:

"rle " (Animation)
"WRLE" (BMP)

"cvid" (Cinepak)

"yuv2" (Component Video)
"dvcp" (DV - PAL)

"dve " (DV/DVCPRO - NTSC)
"dvpp" (DVCPRO - PAL)
"jpeg" (Foto - JPEG)
"smc " (Grafik)

"h261" (H.261)

"h263" (H.263)

"avcl" (H.264)

"mjp2" (JPEG 2000)

"raw " (None)

"mp4v" (MPEG-4 Video)
"mjpa" (Motion JPEG A)
"mjpb" (Motion JPEG B)
"png " (PNG)

"8BPS" (Planar RGB)
"SVQ1l" (Sorenson Video)
"SVQ3" (Sorenson Video 3)
"tga " (TGA)

"tiff" (TIFF)

"rpza" (Video)
[--exportAudioFourCC|-audiofourcc <FourCC>]
Set one of the following FourCC codes for QuickTime audio export:
"alaw" (A-Law 2:1)

"aac (AAC)

"alac" (Apple Lossless)
"lpcm" (Linear PCM)
"aach" (MPEG-4 HE AAC)

"ulaw" (p-Law 2:1)
[--exportBurnInSubtitles|-burnsub]
Burn in subtitles.
[-—exportBurnInSubtitlesVOffset|-burnsubvoffs] <offset 0-100>
Set additional vertical offset from bottom in procent 0-100.
[--exportBurnInSubtitlesType|-burnsubtype]
Set one of the following codes:
"OpenSubtitle"
"MainSubtitle"
"ClosedSubtitle"
"OpenCaption"
"MainCaption"
"ClosedCaption"
"MainClosedCaption"
[-—exportBurnInSubtitlesLanguage|-burnsublang]
Set specific language of subtitle.
None (default) means all available languages for the given type are used.
[--exportBurnInTimecode | -burntc]
Burn in time-code.
[--exportBurnInTimecodeVOffset|-burntcvoffs <offset 0-100>]
Specify vertical offset from bottom in procent 0-100.
[-—exportBurnInTimecodeColor|-burntccolor <color e.g. "red", "#RGB",
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"#RRGGBB">]

Set color for burning-in time-code.
[-—exportBurnInTimecodeFont | -burntcfont <color e.g. "arial">]

Set font for burning-in time-code.
[-—exportBurnInTimecodeFontSize|-burntcfontsize <font size in points>]

Set font size for burning-in time-code.
[--exportBurnInText | -burntxt <text>]

Burn in static text, e.g. "property of Fraunhofer IIS".
[-—exportBurnInTextVOffset|-burntxtvoffs] <offset 0-100>

Specify vertical offset from bottom in procent 0-100.
[--exportBurnInTextColor|-burntxtcolor] <color>

Set color for burning-in text.

Format can be "red", "#RGB" or "#RRGGBB"
[-—exportBurnInTextFont|-burntxtfont] <color e.g. "arial">

Set font for burning-in text.
[-—exportBurnInTextFontSize|-burntxtfontsize] <font size in points>

Set font size for burning-in text.

11.1  On Windows

On Windows, the command prompt or a script (e.g. a batch file) would
typically be used pass command line parameters to easyDCP Player. easyDCP
Player.exe / easyDCP Player+.exe were built using the Windows Subsystem and
therefore their output is not visible in the command prompt. Instead, easyDCP
Player.com / easyDCP Player+.com should be used. Since the executable file

"

contains a space, enclose any calls into “”, e.g.

C:\>"Program Files (x86)\Fraunhofer IIS\easyDCP Player\bin\easyDCP
Player+.com” -help

11.2 On MacOS X

On Mac OS X, the terminal or a script (e.g. a shell script) would typically be
used to pass command line parameters to easyDCP Player. The easyDCP Player
application is in truth a directory called “easyDCP Player.app”. The executable
file which can be started and passed parameters is “easyDCP
Player.app/Contents/MacOS/easyDCP Player”. Since the executable file contains

"

a space, enclose any calls into “”, e.qg.

Mymac:~ user$ “/Applications/easyDCP Player+ 3.3.0.app/Contents/MacOS/easyDCP
Player+ 3.3.0” -help
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12

12.1

12.2

12.3

Limitations

DCPs

DCPs split across multiple volumes (Vollndex) are not supported.

“E-Cinema” DCPs with MPEG2 essence are not supported.

IMPs
The GPU-based codec supports IMPs in versions 3.3.0and later. In older
versions, they can be decoded with the software-based codec.
Resolutions higher than 4K are not supported.
Rendering of IMF subtitles is an experimental feature.

Timed Text

The timed text formats specified for Interop DCPs, SMPTE DCPs and IMF
packages are supported.

Only a subset of the elements defined in DLP Cinema™ Projection Technology
(“Interop timed text”), SMPTE 428-7 (“SMPTE timed text”) and TTML IMSC1
("IMF timed text"”) are supported. This subset covers PNG as well as text
subtitles or captions, rendered horizontally with or without custom fonts,
outlines or shadows. A not exclusive list of ignored elements are ruby
characters, attributes related to rotation, attributes related to scaling, ,
attributes and related to stretching.

Stereo 3D subtitles are not supported.
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13 Frequently Asked Questions (FAQS)

please refer to FAQs at www.easydcp.com
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14 Disclaimer

The fact that easyDCP Player and easyDCP Player+ are able to playback a media
asset, e.g. DCP, does not guarantee that another piece of software or Digital
Cinema server, regardless which vendor, will also playback the asset.

Being a software solution, easyDCP Player does not contain a Secure Media
Block (SMB). Therefore it does not comply with the DCI's security requirements
being applied to playback servers used for commercial screenings in a theatre
environment. easyDCP Player is designed to be a quality control tool.
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15

Contact

We appreciate very much to have your feedback and your annotations about
easyDCP Player and easyDCP Player+. In order to enhance the software and to
optimize it for your applications, we are looking forward to your cooperation.

If you have any problems or questions, please contact us at the following
addresses:

Sales & Technical Support

easyDCP GmbH
Eiblwiesweg 2

82418 Murnau, Germany
info@easyDCP.com

Product Management

Fraunhofer Institute for Integrated Circuits IS
Department Moving Picture Technologies
Heiko Sparenberg

91058 Erlangen, Germany
heiko.sparenberg@iis.fraunhofer.de
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